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1. Características e Funcionalidades

Esse documento descreve como a aplicação trabalha para calcular e plotar no CAD as
seções transversais do túnel, levantadas com estação total. Este programa é um complemento
ao programa para coleta de dados e locação TcpTunnel para Windows CE, além disso arquivos
gerados de outras aplicações disponíveis no mercado também podem ser usados.

A aplicação permite definir um projeto a partir de alinhamentos horizontal e vertical,
opcionalmente superelevações e seções-tipo onde seus parâmetros são especificados. Alguns
dados também podem ser copiados para o dispositivo móvel para ser usado no programa
descrito acima.

Uma vez que os dados de coordenadas dos pontos correspondem ao levantamento da
estação total, é possível plotar as seções transversais obtidas com diferentes opções, renderizar
os dados teóricos e os medidos em um diagrama 3D, afim de se obter relatórios de pontos e
volumes.

2. Comandos de referência

2.1 New Project

Para evitar lembrar de cada arquivo que compõem o projeto, um arquivo para gravar
os links de cada um dos arquivos essenciais é criado.

Todos os componentes devem ser colocados na mesma pasta onde o projeto é criado.

Uma vez definido o nome do projeto, será exibida uma tela para que os arquivos que
compõe o projeto sejam selecionados:
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Os botões Points, Control Points, Horizontal Alignment, etc. permitem selecionar cada
um dos componentes que compõem o projeto. De todos eles, estaca e superelevação não são
obrigatórios.

Em  Template  Orientation,  deve-se  informar  se  os  perfis  criados  são  verticais  ou
perpendiculares ao alinhamento horizontal. A última opção deve ser usada para túneis com
grandes declividades.

Vertical

 Perpendicular ao alinhamento vertical

Pressionando  o  botão  Edit… é  aberto  um  editor  para  criar  ou  modificar  o  item
selecionado. Com o botão OK cria-se o projeto indicado contendo os arquivos selecionados.

Os diferentes tipos de arquivos requisitados são descritos abaixo.

2.1.1 Points

Os pontos levantados pertencentes ao projeto atual são gravados em arquivos no 
formato ASCII. Esses arquivos devem ter a extensão *.PUN (compatível com MDT) e contém os 
dados descritos a seguir para cada ponto, separado por espaço:

<Número> <Coordenada X> <Coordenada Y> <Coordenada Z> <Código>

Nome Tipo Comprimento Nº de decimais Observação

N Alfanumérico 14 0 Nº do ponto

X Numérico 11 3

Y Numérico 11 3

Z Numérico 8 3

Código Alfanumérico 14 -
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Arquivos no formato GSI podem ser selecionados diretamente, A aplicação importará 
automaticamente cada arquivo e criar o arquivo *.PUN correspondente.

2.1.2 Stations

As estacas do levantamento do projeto atual  são gravadas em arquivos no formato
ASCII. Esse arquivos tem a extensão *.BSE (compatível com MDT) e contém os dados abaixo de
cada estaca, separados por espaço:

<Número> <Coordenada X> <Coordenada Y> <Coordenada Z> <Distorção> <Código>

Nome Tipo Comprimento Nº de decimais Observação

Estaca Alfanumérico 8 - Nome da estaca

X Numérico 11 3

Y Numérico 11 3

Z Numérico 8 3

Código Alfanumérico 14 -

Escala Numérico 9 8

2.1.3 Horizontal Alignments

Esses arquivos também são compatíveis com o formato dos aquivos TCP-Digital Terrain
Model (*.EJE).

Os arquivos possuem os campos descritos abaixo:

Nome Tipo Comprimento Nº de decimais Observação

Estaca Numérico 11 3 Quilometragem
do ponto

X Numérico 11 3

Y Numérico 11 3

Azimute Numérico 8 4

Parâmetro Numérico 9 3 Parâmetro do
Clotóide

Raio Numérico 9 3
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2.1.4 Vertical Alignments

Esses arquivos também são compatíveis com o formato dos aquivos TCP-Digital Terrain
Model (*.RAS).

Os arquivos possuem os campos descritos abaixo:

Nome Tipo Comprimento Nº de decimais Observação

Estaca Numérico 11 3 Quilometragem
do ponto

Cota Numérico 8 3 Cota do vértice

Raio Numérico 9 3

Tangente Numérico 9 3

Direção Numérico 9 3

2.1.5 Superelevations

Esses arquivos também são compatíveis com o formato dos aquivos TCP-Digital Terrain
Model (*.PER).

Os arquivos possuem os campos descritos abaixo:

Nome Tipo Comprimento Nº de decimais Observação

Estaca Numérico 11 3 Quilometragem
do ponto

PL Numérico 6 3 Superelevação no
lado esquerdo

PR Numérico 6 3 Superelevação no
lado direito

Se o valor do lado esquerdo e do lado direito é “B”, indica que há escoamento. Em
outras palavras, o valor para os dois lados é de -2%.

2.1.6 Tunnel Templates

Esse tipo de arquivo grava as informações das seções-tipo do túnel ou as seções-tipo
ao longo dos alinhamentos do projeto (Veja em comando Edit Tunnel Templates).

A extensão desse tipo de arquivo é *.TNL.

2.1.7 Cross-Sections
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Esse  tipo  de  arquivo  grava  as  informações  sobre  os  perfis  medidos.  É  criado  dos
alinhamentos horizontal e vertical, seções-tipo e pontos medidos.

Os arquivos são formados pelos campos abaixo:

Nome Tipo Comprimento Nº de decimais Observação

Estaca Numérico 11 3 Quilometragem
do ponto

Offset Numérico 8 3 Offset do ponto
relativo ao

alinhamento

Cota Numérico 8 3 Cota do ponto

Número Alfanumérico 16 - Número do ponto
medido

A extensão desse tipo de arquivo é TRI.

2.2 Open Project

Com esse comando pode-se alterar o projeto atual. Todos os outros comandos serão
usados no projeto carregado.  Caso não exista  projeto para ser  aberto,  será perguntado se
deseja criar um novo projeto.

Caso seja criado um novo desenho no CAD, o mesmo irá perder p projeto carregado, e
para qualquer outro comando realizado será preciso carregar o projeto novamente.

2.3 Project Edit

Esse comando permite alterar os arquivos usados no projeto existente.
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As mudanças realizadas no projeto selecionado serão gravadas clicando no botão OK.

2.4 Edit Tunnel Template

Esse comando permite editar o arquivo de seções (*.TNL) que será usado ao longo de
todo o comprimento dos alinhamentos do projeto a ser criado.

O comando exibe a caixa de diálogo com as seções criadas.

New: essa opção cria uma nova seção-tipo, que deve ter sido desenhada antes de ser
atribuída graficamente.

Edit: permite editar uma seção-tipo existente.

Delete: apaga a seção-tipo selecionada.

Qualquer alteração nas seções-tipo criadas ou apagadas somente serão gravadas ao
fechar a caixa de diálogo usando o botão OK.
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2.4.1 New Tunnel Template

A seção-tipo é definida de uma polilinha. A polilinha pode ser aberta ou fechada, e
pode ser gerada tanto no sentido horário quanto no sentido anti-horário. Uma vez selecionada
(Select Tunnel Template) os dados a seguir são requisitados:

Name: nome da seção-tipo. S1 é mostrado como padrão. Se mais de uma seção-tipo é
criada, as mesmas são nomeadas como S2, S3, etc.

Horizontal distance from H.a. to Center: um valor positivo indica que o alinhamento
plano do terreno está à direita do centro da seção-tipo e o valor negativo indica à esquerda.
Diferentemente para a linha de grade e pontos de aplicação de superelevação, o ponto de
aplicação do plano pode ser definido para ser por fora da seção-tipo.

Vertical distance from Keystone to V.a.: um valor positivo de ser indicado se o ponto
chave  está  acima  da  linha  de  grade  e  do  ponto  de  aplicação  da  superelevação  e  o  valor
negativo é o inverso. Sob condições normais, o valor deve ser sempre positivo. A linha de grade
e o ponto de aplicação da superelevação devem estar na parte interna da seção.

Horizontal distance from a V.a. to H.a.: neste caso a referência é o ponto de aplicação
do  alinhamento  no  plano  do  terreno.  Um  deve,  portanto,  indicar  um  valor  positivo  se  o
alinhamento vertical e o ponto de aplicação da superelevação estão à direita do alinhamento e
negativo se está à esquerda.

Advanced  (Superelevations): se  o  arquivo  de  superelevações  foi  selecionado,  o
programa permite inclinar a seção-tipo dependendo do valor da superelevação.
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Manter a seção-tipo fixa Seção-tipo inclinada

 

2.4.2 Edit Tunnel Template

Esse comando permite alterar os parâmetros das seções já existentes. Primeiro, deve-
se  indicar  o  ponto  de  inserção  dentro  do  desenho.  Então  a  caixa  de  diálogo  Edit  Tunnel
Template é mostrada (veja New Tunnel Template).

2.5 Tunnel Template Assignments

Depois das seções-tipo serem definidas, as mesmas devem ser atribuídas às seções.

Para  criar  as  atribuições,  selecione  umas  das  seções-tipo  criadas  na  caixa  Tunnel
Templates e especifique os parâmetros.
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Final Station: estaca até onde a seção-tipo selecionada é aplicada.

Use os botões a seguir para alterar as atribuições.

Insert: insere uma nova atribuição com os valores inseridos.

Edit: abre a caixa de diálogo para editar os valores da atribuição selecionada.

Delete: apaga a atribuição selecionada.

Delete All: apaga todas as atribuições.

A aplicação interpolará as seções-tipo entre cada atribuição, se possível setá indicada
na tabela. Se não houver interpolação, uma cópia da atribuição prévia deve ser criada.

Sair da caixa de diálogo com o botão OK grava todas as alterações realizadas.

2.6 Calculate Cross-Sections

Essa  opção  calcula  as  seções  transversais  com  os  pontos  do  projeto,  para  isso  o
alinhamento é necessário. As seções transversais calculadas são gravadas no arquivo de seções
do projeto, no formato *.TRI.
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Initial Station: estaca onde os pontos foram medidos e que as seções serão iniciadas. O
alinhamento do projeto é indicado próximo da estaca inicial.

Final  Station: estaca onde os pontos foram medidos e que as seções terminam. O
alinhamento do projeto é indicado próximo da estaca final.

Station interval: valor que será incrementado as seções entre as estacas inicial e final.

 Station tolerance: valor de regressão da estaca. Se a diferença entre a estaca analisada
para o ponto e a estaca teórica é menor que esse valor, o ponto no perfil da estaca teórica é
considerado como ajustado.

Minimum point distance: distância mínima entre dois pontos consecutivos do perfil.

Minimum  points: número mínimo de pontos que devem conter no perfil. 

Close cross-sections: após o cálculo de cada seção transversal, o programa juntará o
ponto final e o inicial para criar uma seção transversal fechada. Se a seção transversal é aberta,
a junção entre os pontos não será levada em conta durante o cálculo da superfície. Se for uma
seção transversal fechada, a opção deve ser marcada caso deseja-se que o cálculo de área seja
incluído em todas as seções.

Include non-multiple stations: inicialmente, os arquivos de pontos são analisados e
agrupados juntos à estaca mais próxima de acordo com a tolerância indicada. Essas estacas são
ajustadas de acordo com a tolerância para as estacas aparecerem na lista criada de acordo com
o Station interval. Marcando essa opção, indica-se que se deseja levar em conta estacas que
não foram ajustadas para qualquer múltiplo da estaca inicial indicada de acordo com o Station
interval.
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Round stations: arredonda as seções transversais da estaca ao número inteiro mais
próximo.

Cross-sections Center: essa opção permite definir o ponto que será usado para ordenar
os pontos do perfil. Se a opção Auto é selecionada, o ponto calculado é o centro do retângulo
que  engloba  os  pontos  do  perfil.  De  outra  forma,  pontos  de  aplicação  dos  alinhamentos
horizontal e vertical serão usados. O programa permite alterar esses pontos, entrando com
uma distância horizontal e vertical.

Cross-sections File: arquivo de saída das seções transversais, por padrão será mostrado
o arquivo de seções do projeto.

2.7 Edit Cross-Sections

Essa  ferramenta  permite  editar  as  seções  criadas  anteriormente  para  apagar,
principalmente, os pontos que produzem ruídos no perfil, por exemplo, os pontos de um duto
de ventilação. Veja 13. Editor de Seções Transversais para mais detalhes.

2.8 Draw Cross-Sections

Exibe graficamente as diferenças entre as seções transversais do túnel levantadas em
campo e as seções-tipo.

Para  plotar  as  seções,  é  necessário  configurar  os  requisitos  mostrados  na  figura  a
seguir:
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Initial Station: estaca a partir de onde os pontos foram medidos e serão plotadas as
seções. O alinhamento do projeto é indicado próximo da estaca inicial.

Final station: estaca até onde os pontos foram medidos e serão plotadas as seções. O
alinhamento do projeto é indicado próximo da estaca final. 

Minimum Height: cota com relação à linha de grade para cortar as seções transversais
e seções-tipo, por uma linha horizontal.

Os elementos que se  desejam mostrar  podem ser  selecionados na seção Drawing,
como escala, altura do texto e formato do desenho. Ainda existem opções para plotagem das
seções no modo Continuous ou em certas folhas como DIN-A0, DIN-A1, DIN-A2, DIN-A3 e DIN-
A4.  A  opção  para  plotar  um  perfil  por  folha  (DIN-A4)  também  é  oferecida  como  opção
Individual.

Os elementos para compor o desenho incluem:

Point Number: número dos pontos coletados em campo.

Point Height: cota dos pontos coletados em campo.

Difference: distância perpendicular as seção-tipo para o ponto medido.

Dimensioning Line: linhas  que unem os pontos coletados e  sua projeção na seção
teórica do túnel.

Station: estaca teórica calculada por regressão.

Vertical Alignment Height: cota do alinhamento vertical na estaca teórica.

Superelevation: superelevação no lado esquerdo na estaca teórica.

Horizontal Alignment Coordinates: coordenadas X e Y do alinhamento do plano do
terreno na estaca teórica. 
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Area: área  de  under e  over  e  área total  das  seções teóricas  e  medidas  na  estaca
teórica.

Grid: somente ativada quando a opção Individual é selecionada em Drawing Format.
Mostra um grid que marca distâncias e cotas.

Será necessário selecionar um ponto de inserção para o desenho, então clica-se em
OK.  Vale ressaltar que somente serão levadas em conta as seções teóricas onde houverem
pontos  medidos,  dependendo  dos  filtros  que  foram  aplicados.  Pode  ocorrer  de  nenhum
desenho ser gerado.
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2.9 Draw Tunnel

Mostra um gráfico 3D do túnel teórico e do medido. Em ambos os casos as estacas
iniciais e finais delimitam o desenho requisitado. Caso não exista arquivo de seção transversal
no projeto, ou o mesmo esteja vazio, a seção correspondente aparecerá desabilitada.

Elementos a serem desenhados podem ser selecionados independentemente do túnel
teórico ou medido. Os pontos e as seções serão desenhados em ambos os casos, e as linhas
longitudinais  no  caso  do  túnel  teórico.  A  distância  entre  os  pontos  teóricos  podem  ser
inseridos na caixa Discretiziation distance.
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3. Relatório de Áreas e Volumes

Seguem descrições das partes comuns das listas de áreas e volumes. Qualquer umas
das opções mostrarão a caixa de diálogo comum para os parâmetros.  Ambos os relatórios
necessitam dos mesmos parâmetros.

Initial Station: estaca onde o cálculo de volume inicia.  O alinhamento do projeto é
indicado próximo à estaca inicial.

Final  Station: estaca  onde o cálculo  termina.  O alinhamento do projeto é indicado
próximo à estaca final.

Minimum height: com em relação à linha de grade para cortar a seção transversal e
seção-tipo, por uma linha horizontal.

Uma vez que os dados foram inseridos, a lista é mostrada após clicar no botão OK.

3.1 Area Report

Se o relatório de áreas foi selecionado, o relatório será mostrado como o da figura
abaixo:
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Station: mostra as estações onde os pontos foram levantados.

Perimeter: perímetro da seção transversal.

Area: área formada pela seção transversal anterior e a próxima da lista. Calculada pelo
Método da Área Média:

A = (PerímetroFST + PerímetroIST) * ((FST – IST)/2)

onde:

FST = Estaca final do intervalo.

IST = Estaca inicial do intervalo.

PerímetroFST = Perímetro da seção trasnversal final do intervalo.

PerímetroIST = Perímetro da seção trasnversal inicial do intervalo.

3.2 Volume Report

Se o relatório de volumes é selecionado, o relatório será mostrado como o da figura
abaixo:

Station: mostra a estaca onde os pontos foram levantados.

Overex. Area: área de excesso de escavação na estaca indicada.

Underexc. Area: área a ser escavada na estaca indicada.

Exc. Area: área escavada na estação indicada.

Overex. Vol: volume do excesso de escavação entre a anterior e a próxima estaca da
lista. É calculada pelo Método das Áreas Médias:

V = ((Fst – Ist)/2) * (SurFSt + SurISt)
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onde:

Fst: estaca final do intervalo

Ist: estaca inicial do intervalo

SurFSt: superfície do excesso de escavação ou superfície a ser escavada calculada na
estaca final do intervalo.

SurISt: superfície do excesso de escavação ou superfície a ser escavada calculada na
estaca inicial do intervalo.

Underexc.Vol: volume existente a ser escavado entre a anterior e a próxima estaca da
lista. Calculada usando o mesmo método do volume de escavação existente.

Exc.Vol: volume da escavação existente entre a anterior e a próxima estaca da
lista. Calculada usando o mesmo método do volume de escavação existente.

Total Overexcavation Volume: todo o volume de escavação entre a estaca final e inicial
da lista.

Total Underexcavation Volume: todo o volume a ser escavado entre a estaca final e
inicial da lista.

Total Excavation Volume: valor do volume escavado da lista.

Print: permite que o conteúdo da lista seja trasferido para o papel, um documento do
Word, um documento Excel, etc.

 3.3 Point Report

Exibe um relatório  contendo a  informação sobre  os  pontos  no  arquivo  contido no
projeto selecionado.

Os dados a seguir são exibidos para cada ponto:

Number: número do ponto.

X, Y, Z Coord: coordenadas dos pontos.

Station: estaca do ponto com relação ao alinhamento do projeto.

Offset: distância com relação ao alinhamento horizontal do projeto.
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Height Dif.: diferença de cota com relação ao alinhamento vertical, que a coordenada Z
– cota da linha de grade no ponto da estaca.

Difference: distância do ponto com relação à seção teórica, valores negativos indicam
que o ponto está fora da seção, ou ponto de over escavação. Se nenhuma seção teórica foi
atribuída à estaca desses pontos, este campo aparecerá vazio.

Code: código do ponto que foi inserido no arquivo de origem dos pontos.

3.4 Offset Report

Se a seção transversal do túnel é circular, o offset de cada estaca pode ser calculada
pelo centro geométrico calculado para cada seção transversal e a medição é ajustada.

Atualmente, essa opção não será usada, a menos que a seção transversal seja circular.

Quando  o  comando  é  selecionado,  a  janela  a  seguir  é  exibida,  onde  as  seções
transversais e o intervalo de estaca podem ser selecionados.

Initial  Station: estaca  inicial  para  cálculo  do  offset.  A  menor  estaca  das  seções
transversais é mostrada por padrão.

Final Station: estaca final para cálculo do offset. A maior estaca das seções transversais
é mostrada por padrão.

Quando o botão OK é pressionado, o programa calcula os offsets do túnel com a seguir:

1. Cria grupo de pontos formados por três pontos.

2. Para cada grupo é calculado o ponto médio do círculo (a razão da seção transversal
ser sempre representada como uma circunferência).

3. Acumula offset horizontal  e vertical  do meio do círculo com relação ao meio da
seção transversal.

4. Média dos offsets com o número de grupos criados.

Os dados calculados são exibidos como no relatório mostrado a seguir:
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Station: estaca da seção transversal usada para calcular o offset.

Horizontal: offset horizontal das seções transversais com relação ao plano do terreno.

Vertical: offset vertical das seções transversais com relação à elevação do alinhamento.

X, Y,  Z Coord: coordenadas 3D do offset do alinhamento com relação à estaca em
questão.

Para a representação gráfica dos cálculos, selecione Draw, que exibirá uma caixa de
diálogo  para  configuração  do  formato  de  entrada/saída.  As  opções  são  as  mesmas  para
desenhar as seções transversais. 

A seção transversal é colorida em azul, as seções-tipo em verde. O local onde a seção
transversal teórica com dado de offset aplicado será mostrado em vermelho.
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4. 3D Model

Esse grupo de opções permite gerar uma triangulação 3D do túnel, realizar uma rota
dentro do túnel e exportar diversos formatos de arquivos de definição geométrica, como OBJ e
OFF.

4.1 Draw

Essa  opção  realiza  a  triangulação  3D  e  exibe  o  desenho  da  mesma  ao  longo  do
alinhamento horizontal do projeto.

Para realizar isso, o programa solicita as estacas inicial e final e o número do pontos
que serão criados para cada perfil.

4.2 Tunnel Traveling

Após o modelo 3D do túnel ser desenhado, o programa permite realizar uma rota pela
parte interna do mesmo. Para isso, o programa requisita os dados a seguir:

Observer height: altura que a câmera estará posicionada, em metros.

Movement: direção de avanço do túnel, que pode ser direta ou inversa.
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Interval: incremento do progresso para cada passo, em metros.

4.3 Export

Programa permite exportar, o modelo 3D criado, para formatos OBJ e OFF para ser
visualizado em outras aplicações.
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5. Check Tolerances

Essa  opção  permite  verificar  se  os  perfis  medidos  estão  dentro  da  tolerância.  O
programa solicita um arquivo de perfil, as estacas inicial e final e as tolerâncias de escavação.

Após  inserir  os  dados,  clicando  no  botão  OK,  o  programa  exibirá  o  relatório  de
tolerâncias.

O relatório exibe o perfil da estaca, o número do ponto e a diferença. A última coluna é
exibida, com um asterisco, caso os pontos estejam dentro das tolerâncias definidas.

Clicando no botão Edit, o programa exibirá graficamente o perfil selecionado.
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6. Compare Cross-Sections

Esse comando permite comparar dois arquivos de seções transversais de diferentes
estágios do projeto.

TcpTunnel > Compare Cross-Sections exibirá a caixa de diálogo a seguir:

Na área das seções transversais, selecione dois arquivos diferentes. Serão exibidos para
cada um, o intervalo de estacas em que estão definidos.

O primeiro dos dois arquivos selecionados será usado como referência nos cálculos de
volumes e áreas de superfície. Além disso, as áreas de escavações correspondem às áreas do
segundo arquivo de seções com relação ao primeiro arquivo.
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Quando o botão OK na caixa de diálogo é pressionado,  a  lista de comparação dos
arquivos de seções é exibido. O primeiro arquivo é usado como referência para os volumes
internos e externos.

O programa sempre fechará as seções transversais para realizar os cálculos de áreas e
volumes.

Pressionando  o  botão  Draw no  relatório  de  volumes  é  realizado  o  desenho  da
comparação das seções transversais. Será exibida a caixa de diálogo com a do desenho das
seções transversais, porém com menos opções.

Quando a comparação das duas seções são desenhadas, as duas seções transversais
serão exibidas como fechadas para que seja calculada a área da superfície.
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7. General Settings

Essa opção permite alterar alguns parâmetros da configuração do programa.

 

Station Analysis

Permite ativar ou desativar os limites para análise das estacas. Essa característica é
mais  usada  para  alinhamento  horizontal  espiral  ou  alinhamentos  horizontais  com  seções
transversais de diferentes cotas. O programa solicita as diferenças máximas à esquerda e à
direita  do  alinhamento  horizontal  e  as  diferenças  máximas  acima  e  abaixo  das  cotas  do
alinhamento vertical.

Para  cada  ponto,  o  programa  calculará  algumas  soluções  da  estaca  ao  longo  do
alinhamento horizontal e então, selecionará a estaca onde o ponto está abaixo dos valores
definidos nos quatro parâmetros.

Essa característica é usada nas opções Calculated Cross Sections e Point Report.

Language

Permite alterar a linguagem do programa. Inglês e Espanhol podem ser selecionados.

8. About

Exibe janela com a versão do programa e número de revisões.
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9. Relatórios

A opção do botão Print permite transferir os dados exibidos na tela para diferentes
destinos.

Title: título do documento.

Number of pages: indica se deseja incluir o número das páginas para a opção Printer.

First Page: numeração da primeira página.

Destination: indica para onde se deseja transferir a informação. Caso a opção Printer
seja  selecionada,  pode-se  selecionar  e  configurar  a  impressora  clicando  no  botão  …  que
aparece  na  caixa  Printer no  lado  direito  da  tela.  Quando  a  opção  File é  selecionada,  a
informação é transferida para um arquivo de texto.  Pode-se também selecionar  as opções
Replace ou  Add para  substituir  ou  adicionar  informações  em  um  arquivo  já  existente.  O
documento pode ser aberto uma vez que a impressão está completa (Open Editor). A opção
HTML cria um documento HTML que pode ser aberto com o navegador de internet. Por último,
as opções MS Word e MS Excel criam arquivo Microsoft Word e Microsoft Excel.

Do not show this dialogue box again, unless …: Uma vez que o formato de destinação
dos arquivos foi configurada, a caixa de diálogo não sera mais exibida caso essa caixa esteja
marcada, a menos que a tecla Ctrl for mantida pressionada. 
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10. Horizontal Alignment editor

O programa permite editar, visualizar e modificar os alinhamentos horizontais (*.EJE).
O editor pode trabalhar com vários arquivos ao mesmo tempo, e cada uma terá sua própria
janela com sua representação gráfica.

10.1 Menu File

New: abre uma janela vazia para inserir um alinhamento horizontal manualmente.

Open: abre o seletor de arquivo para carregar um alinhamento horizontal existente.

Close: fecha a janela ativa. Se o alinhamento horizontal  foi  modificado, a aplicação
solicitará confirmação antes do fechamento da janela.

Save: grava o alinhamento sem perguntar o nome do arquivo.

Save as: abre o seletor de arquivo para salvar o alinhamento com um novo nome.

Import: usa o menu para importar um alinhamento de outro formato. Os diferentes
formatos disponíveis são descritos abaixo.

Export DXF: cria arquivo DXF equivalente à representação gráfica. Qualquer camada
oculta não será exportada.

Quit: ao sair da aplicação, será exibida uma caixa de diálogo para cada janela aberta, e
cada  uma  que  teve  os  dados  alterados  estarão  marcadas.  Ao  pressionar  OK,  todos  os
alinhamentos marcados serão salvos.

10.2 Inserindo alinhamento horizontal manualmente
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Para inserir o alinhamento, os dados devem ser inseridos da esquerda para a direita.
Um alinhamento somente será inserido ou modificado após ser inserido o campo Length.

Se  um  alinhamento  intermediário  é  modificado,  deve-se  aceitar  todos  os  valores
diferentes até o campo  Length ser buscado e escrever um novo valor ou pressionar  Enter.
Certos campos, como as coordenadas e estaca, são calculados com esse valor e por isso não
podem ser modificados. 

Os  ícone  a  seguir  são  mostrados acima dos  dados numéricos,  da  esquerda para  a
direita são:

Open: abre um novo alinhamento.

Save as: grava o alinhamento com um novo nome.

New:  insere  um  novo  alinhamento  anterior  à  posição  do  cursor.  O  alinhamento
anterior será dividido em dois, respeitando o comprimento do alinhamento e o azimute das
seções. Ocorre o mesmo ao pressionar a tecla Insert do teclado. 

Edit: o botão editar não está disponível.

Delete: apaga o alinhamento onde o cursor está posicionado.

Search: abre a caixa de busca, onde pode ser inserido um ou mais valores de cada
campo, e a aplicação buscará o alinhamento mais próximo à busca.

Delete All: apaga todo o alinhamento.

Export: exporta o alinhamento para um arquivo ou impressora. Essa opção não pode
ser usada para exportar para outros formatos.

10.2.1 Adicionar reta

Para adicionar uma seção reta, defina o parâmetro e o campo do raio como zero.

Para alterar a direção da reta, modifique o valor do azimute. Por padrão, a aplicação
sempre marca o azimute de saída da seção anterior.

Seções não podem ser criadas com comprimento igual a zero.

10.2.2 Adicionar curva

Para  adicionar  uma  curva,  defina  o  parâmetro  como  zero  e  escreva  o  raio
correspondente.

Se o raio da curva for maior que zero, a direção da curva será para a direita de acordo
com a direção do alinhamento, e se o valor é negativo, a curva será para a esquerda.

O valor do azimute proposto é o azimute de saída da seção anterior. O programa não
permite a alteração do azimute em seções de curvas.

10.2.3 Adicionar clotóide
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Para adicionar um clotóide, um parâmetro maior que zero deve ser inserido.

Se o raio inserido for maior que zero, indicará a clotóide de entrada. Um raio igual a
zero indica um clotóide de saída, que somente pode vir após uma curva.

10.3 Representação gráfica

Se desejar ver uma representação gráfica do alinhamento, pressione a aba  Graphic
View. Para configurar a marca de dimensionamento e as cores, usa a caixa de diálogo em Tools
> Configuration.

10.4 Ferramentas

10.4.1 Mover alinhamento

Muda  os  valores  para  criar  um  alinhamento  paralelo  ao  atual.  Um  valor  negativo
moverá o alinhamento para a esquerda, e um valor positivo, para a direita.

10.4.2 Ajustar estaca

Muda a estaca inicial do alinhamento.

10.4.3 Inverter alinhamento

Muda a direção do alinhamento, sem alterar seu comprimento.

10.4.4 Configuração

A  representação  gráfica  do  alinhamento  pode  ser  alterada  pela  modificação  dos
parâmetros de elevação e cores para representar cada uma das marcas.

Permite alterar as cores e distâncias das marcas curtas e longas, como também dos
pontos únicos.

Text height: altura dos textos em metros.

Short marks interval: distância em metros entre as marcas curtas. Ao lado há um botão
para atribuir a ela a diferença de cores, e o botão Options … pode ser usado para configurar o
formato das marcas.
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Long marks interval: distância em metros entre as marcas longas. A cor e o formato
das marcas podem ser configuradas.

Unique points: somente a cor e o formato dos pontos únicos podem ser configurados.
Essa marca surgirá no início de cada linha, curva ou clotóide.

Alignment: para alterar a cor do alinhamento.

Para restaurar os valores padrão, pressione o botão Restore. 

10.4.4.1 Formato das marcas e dos pontos únicos

Quando o botão Options… é pressionado, a caixa de diálogo a seguir é exibida, em que 
os valores de cada tipo de marca selecionada pode ser alterado.

Mark  length: comprimento  da  marca.  A  linha  será  perpendicular  ao
alinhamento.

Extension length: caso exista um texto no desenho, esse é o valor da extensão
dos textos anexados às marcas.

Align  texts: os  textos  podem  ser  alinhados  à  esquerda,  à  direita  ou  não
alinhado à nada.



35

As opções disponíveis  para  pontos  únicos  são as  mesmas para  as  marcas  curtas  e
longas. Pode-se indicar se o texto é interno ou externo.

10.5 Importando alinhamento

Os alinhamentos  podem ser  importados  de  outros  formatos.  Os  alinhamentos  são
normalmente importados nos formatos Inland, LandXML e MXRoad.

Para importar o alinhamento, abra o menu File > Import e escolha o tipo apropriado.

11. Vertical alignment editor

Essa aplicação permite editar, visualizar e modificar os alinhamentos verticais (*.RAS).
O editor  pode trabalhar  com vários  arquivos  ao mesmo tempo,  e  cada um deles  terá sua
própria janela com sua representação gráfica.

11.1 Menu File

New: abre uma janela vazia para inserir o alinhamento vertical manualmente.

Open: abre o seletor de arquivo para carregar um alinhamento vertical existente.

Close: Fecha a janela ativa. Se o alinhamento vertical possui modificações, a aplicação
perguntará se deseja salvar antes de fechar.

Save: grava o alinhamento vertical sem perguntar o nome do arquivo.

Save as: abre o seletor de arquivo para gravar o alinhamento com um novo nome.

Import: usa  o  menu para  importar  um alinhamento  vertical  de  outro  formato.  Os
diferentes formatos disponíveis são descritos abaixo.
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Quit: ao sair da aplicação, será exibida uma caixa de diálogo para cada janela aberta, e
as  que sofreram alterações estará  marcadas.  Se  OK é  pressionado,  todos os  alinhamentos
marcados serão gravados.

11.2 Inserção manual

Para inserir um alinhamento vertical, primeiro entre com  Station (estaca) e  Heights
(cota), o programa automaticamente moverá o cursor por essas duas colunas. Então pode-se
alterar  os dados de acordo com o desejado.  Isso é necessário  porque os dados das linhas
anteriores e posteriores são necessárias para calcular de acordo com a linha inserida.

A aplicação calculará se ocorre alguma sobreposição entre as seções, e a célula onde a
sobreposição  ocorre  será  exibida  em vermelha,  se  a  sobreposição  é  em um ponto  chave,
tangente ou direção é inserida, os valores suplementares não serão calculadas.

Para adicionar mais dados, vá até a última linha e pressione Cursor down, a nova linha
para adicionar mais dados aparecerá. Ao deixar a nova linha sem qualquer alteração, a mesma
será apagada automaticamente. 

Os ícones a seguir são exibidos acima dos dados numéricos, da esquerda para a direita
são:

Open: abre um novo alinhamento vertical.

Save as: grava o alinhamento vertical com um novo nome.

New: insere um novo elemento após a posição do cursor. O elemento é dividido em
dois, respeitando os valores. O mesmo acontece quando pressionado Insert.

Edit: o botão para editar não está disponível.

Delete: apaga o elemento onde o cursor está localizado.

Search: abre a caixa de busca, onde pode-se inserir um ou mais valores de cada campo,
e a aplicação localizará o elemento mais próximo.

Delete All: delete todo o alinhamento.

Export: exporta um alinhamento para um arquivo ou uma impressora. Essa opção não
pode ser usada para exportar para outros formatos.

11.3 Representação gráfica

Caso deseja-se visualizar a representação gráfica do alinhamento vertical, pressione a
aba  Graphic View.  Para configurar o dimensionamento das marcas ou cores, use a caixa de
diálogo em Tools > Configuration.

11.4 Ferramentas

11.4.1 Mover cota
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Modifica a cota do alinhamento vertical respeitando os padrões. Um valor negativo
moverá o alinhamento para baixo, e um positivo para cima.

Quando a cota do alinhamento é movida, os padrões não são alterados.

11.4.2 Ajustar estaca

Muda a estaca inicial do alinhamento vertical, sem modificar os padrões.

11.4.3 Configurações

Acessada em Tools > Configuration.

As camadas a seguir aparecem na representação:

Short  marks: desenha uma linha vertical  da cota mínima para  a linha de grade.  A
distância entre essas marcas é configurável.

Long marks: desenha uma linha vertical  da  cota  mínima para  a  linha  de grade.  A
distância entre essas marcas é configurável.

Unique Points: cor dos pontos únicos. Desenha uma linha vertical nos pontos a seguir:

• Estaca – tangente

• Estaca + tangente

• Estaca onde a tangente é igual a zero

Guitar: cor das linhas de separação e legenda.

Grade line: cor da representação gráfica da linha de grade.

Previous grade line: cor da polilinha formada pela estaca de cada ponto único e sua
cota.

11.5 Importar alinhamento vertical

Alinhamentos  verticais  podem  ser  importados  em  outros  formatos.  Os  formatos
aceitos são Inland, LandXML e MXRoad.
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Para importar um alinhamento vertical, abra o menu  File > Import e escolha o tipo
apropriado.

12. Editor de superelevação

Essa aplicação permite editar, visualizar e modificar as superelevações (*.PER). O editor
pode trabalhar com vários arquivos ao mesmo tempo, e cada um terá sua própria janela com
sua representação gráfica.

12.1 Menu File

New: abre uma janela vazia para inserir as superelevações manualmente.

Open: abre o seletor de arquivo para carregar o arquivo de superelevação.

Close: fecha  a  janela  ativa.  Se  as  superelevações  forem  modificadas,  a  aplicação
perguntará se deseja gravar o arquivo modificado.

Save: grava as superelevações sem perguntar o nome.

Save as: abre o seletor de arquivos para gravar a superelevação com um novo nome.

Exit: ao sair da aplicação, exibirá uma caixa de diálogo para cada janela aberta, e cada
uma das alteradas será marcada. Ao pressionar OK, todas as superelevações marcadas serão
gravadas.

12.2 Inserção manual 

Para  adicionar  um alinhamento,  os  dados devem ser  inseridos  da  esquerda para  a
direita.  Um alinhamento somente pode ser inserido ou modificado após inserido o campo
Length.
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As superelevações devem ser inseridas com valores de estacas ascendentes. 

Os ícones a seguir são exibidos acima dos dados numéricos, da esquerda para a direita
são:

Open: abre o arquivo de superelevações.

Save as: grava as superelevações com um novo nome.

New: abre uma caixa de diálogo para inserir uma nova superelevação. Uma nova linha
será inserida seguindo o valor da estaca.

Edit: abre  a  caixa  de  diálogo  para  editar  a  superelevação  atual.  Se  a  estaca  é
modificada, a superelevação será movida para que as estacas fique na ordem ascendente.

Delete: apaga a linha onde o cursor está posicionado.

Find: abre a caixa de diálogo, onde pode ser inserido um ou mais valores para cada
campo, e a aplicação encontrará o alinhamento mais próximo.

Delete All: apaga todas as superelevações.

Export: exportar as superelevações para um arquivo ou impressora. Essa opção não
pode ser usada para exportar para outros formatos.

Pressionar  Insert inserirá  uma nova superelevação com a estaca  que será  o  ponto
médio entre a anterior e a próxima estaca do alinhamento atual. Superelevações à esquerda e
à direita serão interpoladas para manter a mesma inclinação.

Para adicionar mais dados, vá até a última linha e pressione Cursor down, e surgirá a
nova linha para  adicionar  mais  dados.  Ao deixar  a  linha sem nenhuma alteração,  ela  será
apagada automaticamente.

12.2.1 Editar superelevação

Quando o botão New ou Edit é pressionado, a aplicação mostra a caixa de diálogo a
seguir, onde os valores da estaca, superelevação à esquerda e superelevação à direita pode ser
modificada ou inserida.
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Caso a caixa Pumping é marcada, a superelevação com os valores -2.0, 2.0 será criada.

Quando a caixa de diálogo é aberta, a nova superelevação será inserida ou movida (se
for editada), para a linha em que a estaca fica na ordem ascendente.

12.3 Representação gráfica

Caso deseja-se visualizar a representação gráfica das superelevações, pressione a aba
Graphic view.  Para configurar as dimensões das marcas e cores, use a caixa de diálogo em
Tools > Configuration.

12.4 Ferramentas

12.4.1 Ajustar estacas

Muda a estaca inicial das superelevações, sem alterar os valores à esquerda e à direita.

12.4.2 Configuração

A representação gráfica das superelevações pode ser alterada.

Acessada de Tools > Configurations….

Left superelevation: cor da superelevação à esquerda.

Right superelevation: cor da superelevação à direita.

Superelevation text: cor dos textos que aparecerão nas superelevações. Os mesmos 
aparecem em cada item único.

Elevation line: cor das linhas verticais em cada ponto único, e da linha horizontal que 
separa os valores das superelevações positivas e negativas.

Text height: altura do texto desenhado nas superelevações.

Para restaurar os valores padrão, pressione o botão Restore.
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13. Editor de Seções Transversais
Essa aplicação permite editar, visualizar e modificar as seções transversais.

A janela é dividida em duas partes, com o lado esquerdo que mostra as informações
sobre  os  arquivos  abertos,  e  os  dados  das  seções  transversais.  O  lado  direito  exibe  a
representação gráfica da seção transversal.

O editor permite abrir vários arquivos ao mesmo tempo, e para uma estaca específica
mostrará todas as seções transversais que foram definidas na estaca.

Na  parte  inferior  da  janela  há  uma  barra  de  status,  o  lado  esquerdo  mostra  as
coordenadas do cursor. O lado direito exibe a informação do status atual (modificando a figura,
apagando vértices), e sempre mostra a informação sobre a edição gráfica da seção transversal.

13.1 Painel da seções transversais

No lado esquerdo da janela existe um painel que exibe a estaca, arquivo, vértices e
arquivos carregados.

A seguir as descrições das diferentes partes do painel na parte inferior:

13.1.1 Estaca atual

A estação que está sendo visualizada pode ser alterada inserindo o valor ou usando a
barra de rolagem. Se o valor é inserido, a estaca mais próxima será exibida.

Caso existam vários arquivos, rolando através da lista de todas as estacas das seções
transversais.
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Ao lado desses controles e da esquerda para direita são botões para alterar estacas:

First: move para a estaca inicial de todas as seções transversais carregadas.

Prev.: move a estaca anterior.

Next: move para a próxima estação em relação à atual.

Last: move para a estaca final de todas as seções transversais carregadas.

13.1.2 Arquivo atual

A janela flutuante indica o arquivo atual se mais de um arquivo foi carregado. A mesma
aparece com a rota completa.

Se as seções transversais existem em mais de um arquivo para a estaca dada, os dados
podem ser alterados pela alteração dos controles.

13.1.3 Vértices da seções transversais

Os vértices da seção transversal atual são exibidos em uma tabela onde os mesmos
podem ser modificados numericamente.

Caso não existam seções transversais no arquivo selecionado para a estaca atual, esse
painel será desabilitado, e os valores não podem ser alterados.

Se a seção transversal é alterada graficamente movendo ou deletando vértices, essa
tabela será atualizada automaticamente.

Quando uma linha específica é selecionada, a representação gráfica mostrará o vértice
correspondente ao que foi marcado na linha.

13.1.4 Seções transversais na memória

Essa tabela mostra as seções transversais carregadas na memória. Também permite
alterar como serão mostradas na janela gráfica, e alterar suas cores.

13.2 Painel de representação gráfica

O lado direito da janela principal  é  a  representação gráfica das seções transversais
definidas na estaca atual.

Vértices podem ser removidos, apagados ou inseridos nesta janela, usando a barra de
ferramentas.

13.3 Ferramentas

A seguir as opções que podem ser usadas para modificar as seções transversais  no
arquivo selecionado.

13.3.1 Mover alinhamento
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Move as seções transversais horizontalmente. O valor negativo move para a esquerda,
e o positivo move para a direita.

Pode-se escolher onde se aplica o movimento, se na seção transversal atual ou se em
todo o arquivo de seções transversais.

Acessado em Tools > Move alignment ….

13.3.2 Mover cota

Move as seções transversais verticalmente. O valor negativo move para baixo, e o valor
positivo move para cima.

Pode-se escolher onde se aplica o movimento, se na seção transversal atual ou se em
todo o arquivo de seções transversais.

Acessado em Tools > Move Height ….

13.3.3 Inverter tudo

Inverte a direção de todas as seções transversais do arquivo selecionado.

Acessado em Tools > Invert all ….

As seções transversais geradas pelo MDT e TcpTunnel geram os vértices a partir da
direita, ou no sentido horário, e o comando Invert pode ser usado para alterar a direção e
possibilita a sua utilização em aplicações onde os pontos estão na face oposta da direção.

14. Ferramentas gráficas
Todos  os  editores  possuem  uma  barra  de  ferramentas  para  acessar  uma  série  de

comandos,  a  dependendo do  tipo do  editor,  alguns  comandos  podem estar  desabilitados.
Entretanto eles trabalham da mesma forma em todos os editores.

14.1.1  Standard

Essa barra de ferramentas contem as opções usadas mais frequentemente para mover-
se no desenho e aproximar de uma área em particular.

Os botões da esquerda para a direita são:

Zoom in: amplia a vista do desenho a partir do centro do desenho. Pode usar o scroll
do mouse para mover para frente, mas nesse caso a origem e o cursor do mouse.

Zoom out: amplia a vista do desenho a partir do centro do desenho. Pode usar o scroll
do mouse para mover para trás, mas nesse caso a origem e o cursor do mouse.

Zoom Extension: a vista é aumentada ou reduzida de modo a visualizar todos os itens
do desenho, somente são considerados as camadas visíveis.

Zoom Window: zoom em uma área do desenho, o primeiro clique do mouse marca um
canto da janela, e o segundo clique marca o canto oposto.
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Adjustament: o desenho pode ser movido clicando na janela e movendo o mouse sem
soltá-lo na janela.

14.1.2 Layers

Essa  barra  de  ferramentas  permitem  exibir  ou  ocultar  as  diferentes  camadas  do
desenho.

Quando pressionado o controle para baixo, a lista de todas as camadas é exibida. Cada
linha contém os campo a seguir:

• Camadas viíveis, indicada pela lâmpada. Se a camada está apagada, ela não está visível.

• Cor padrão da camada.

• Nome da camada.

14.1.3 Grid 

Inclui  botões  para  habilitar  ou  desabilitar  as  referências  do  desenho  atualmente
visualizados. Somente serão habilitados quando o desenho é 2D.

Os botões da esquerda para a direita são:

Alignments: plota os eixos XY no desenho.

Horizontal  Lines: plota  as  linhas  horizontais  no  desenho  para  mostrar  suas
coordenadas Y.

Vertical Lines: plota linhas verticais no desenho para mostrar as coordenadas X.

Grid: habilita ou desabilita a exibição dos pontos da malha na tela para prover uma
referência visual.

Adjust to grid: restringe as coordenadas do cursor para coordenadas específicas.

Grid properties: exibe a caixa de diálogo para alterar alguns valores do grid,  como
tamanho e cores.

14.1.3.1 Configuração do Grid

A cor do grid, linhas e textos nos desenhos podem ser alterados.

A caixa de diálogo surge quando o botão Configure Grid é pressionado. Através desse
botão surge a janela principal e os editores, os valores de configuração são os mesmos.
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Horizontal Grid: distância entre os pontos do grid no eixo X.

Vertical Grid: distância entre os pontos do grid no eixo Y.

As  cores  do  texto  e  dos  pontos  podem  ser  alterados  pressionando  os  quadrados
apropriados.

Adjust to horizontal: valores para que as coordenadas X do cursor sejam ajustados.

Adjust to vertical: valores para que as coordenadas Y do cursor sejam ajustados.

Esses últimos dois  valores  somente serão aplicados se a  opção  Adjust  to grid está
habilitada.

14.1.3.2 Configuração Guitar

Text height: permite alterar o tamanho do texto exibido próximo às linhas de suporte
horizontal e vertical.

Keep text on screen: o texto que acompanha cada linha é exibido na parte inferior ou à
esquerda da linha. Marque essa opção se o texto não é visível, mas deve ser mostrado no lado
da tela.
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A cor das linhas e dos textos podem ser alterados independentemente para cada tipo
de linha, usando as caixas apropriadas.

14.1.4 Referências para figuras

Referências  para  objetos  permitem selecionar  rapidamente pontos  geométricos  em
figuras  existentes,  sem  conhecer  as  exatas  coordenadas  de  cada  ponto.  Referências  para
objetos podem ser usadas para selecionar o ponto final da linha de um arco, o ponto médio de
um círculo, ou qualquer posição geometricamente significante.

Quando mais de uma referência é ativada, o mais próximos das ativadas será exibida.

Os botões da esquerda para a direita:

Point: marca os pontos próximos à posição do cursor. Somente aplicados para figuras
do tipo ponto.

Close: marco o ponto próximo à posição do cursor, aplicável para qualquer figura.

End Point: marca o lado da figura, ou uma das partes que está próxima à posição do
mouse. Não se aplica a círculos.

Midpoint: marca o ponto médio da figura.

Centre: marco o centro do arco ou circunferência próxima ao mouse.

14.1.5 Helps

Os botões da esquerda para a direita são:

Measure: esse comando permite medir a distância entre dois pontos, primeiro pela
seleção do ponto inicial da medição, e então o ponto final. A distância medida será mostrada
na barra de status. É recomendável ativar as referências para figuras necessárias, ou então a
aplicação pode retornar um dado incorreto se ele não usar as coordenadas corretas do ponto.

Após o segundo ponto ser selecionado, a próxima janela aparece:
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Os valores  dos  pontos  final  e  inicial  nas  linhas  XY,  XYZ  representam a  distância  da
origem ao ponto nos planos XY ou XYZ respectivamente.

Number  Edit:  exibe  a  janela  a  seguir,  onde  as  coordenadas  podem  ser  inseridas
manualmente. No caso de desenhos 2D, a coordenada Z estará desabilitada.

Após entrar com as coordenadas, pressione OK. No modo de coordenadas absolutas,
as  coordenadas  inseridas  serão  adicionadas.  No  modo  de  coordenadas  relativas,  as
coordenadas inseridas serão consideradas incrementos desde o último ponto inserido.

14.2 Modificar

Comando para modificar as polilinhas que formam a seção transversal.

Os botões da esquerda para a direita são:

Insert vertex: insere um vértice no ponto selecionado. Deve ser próximo a um lado.

Delete vertex: elimina o vértice selecionado. É recomendável que tenha uma polilinha
selecionada para visualizar onde estão os vértices.

Delete  vertex  range: marcados  dois  vértices  e  todos  os  vértices  entre  eles  serão
apagados.

Delete vertex window: marque uma caixa e os vértices dentro dela serão apagados.

Exchange  vertices: muda  a  ordem  de  dois  vértices  selecionados  para  criar  uma
polilinha que une os dois pontos.

Join polylines: une as polilinhas selecionadas.

14.3 Mover

Comandos para mover figuras.

Da esquerda para a direita, os ícones são os seguintes:
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Move figure: primeiro selecione a figura para mover, então selecione o ponto como
origem, e por último selecione o ponto como destino. A figura moverá sobre o vetor formado
entre origem  - destino.

Move figure to origin: Primeiro selecione a figura, que atribui um ponto de origem. A
figura será movida sobre o vetor origem da coordenada.

Move figure to the clipboard: esse comando funciona como o descrito anteriormente
(Move figure to origin), porém a figura será copiada para a área ao clipboard. Então vá até a
camada que deseja modificar e cole a figura usando Ctrl+V.

A  melhor  maneira  de  atribuir  as  coordenadas  de  origem  ou  destino  é  usando  as
referências da figura,  ou entrar  com as coordenadas manualmente, usando o comando de
coordenadas.
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